
Quick Start Guide 
 
Running chemlab.exe from Windows 95/98/ME/XP/NT/Windows 2000  
 

1. Click the Windows Start button, and then point to Programs.  
2. Select the ChemLab program in the ChemLab program group. 
3. When ChemLab starts pick a simulation module to load from the simulation 

dialogbox.  
4. When a simulation is started the list of available chemicals, available lab 

equipment and lab text, Introduction, Procedures & Observations, will 
change to reflect the current simulation. 

5. Read the lab introduction in the introduction text window.  
6. Select the procedure tab above the text window and read the procedure. 
7. Then perform the lab following the steps in the procedure.  
8. Record your observations in the observation text window. 
9. Save your lab results in the lab file by selecting File Menu:  “Save” or “Save 

As” Menu option. 
 
Adding Equipment: 
 
Lab equipment is added to the Lab window by either selecting it from the toolbar, 
equipment menu, right mouse context popup menu, or additionally lab equipment 
can also be added through the chemicals dialog box by specifying a new lab 
container.  
 
Adding Water: 
 
Water is added to a selected lab item by using either the toolbar water button, the 
water dialog box. To open the water dialog box, select the water menu item in the 
chemicals menu or the water menu item with the right-mouse-button context 
menu. Water may also be added through the Chemicals dialog box. The toolbar 
button will to a selected item to the next graduation on the container. The users 
may also add ice water; which is used to create ice baths.  
 
 
Adding Chemicals: 
 
To add chemicals to a container first select the container and then select the  
chemicals button from the toolbar or chemicals menu item from either the main 
menu or the right-mouse-button context menu. This will open up a chemicals 
dialog box. The chemicals dialog box allows the users to add chemicals to the 
selected item or add chemicals to a new item. It will also allow the user to change 
the selected containers size and type. Select the desired chemical from the 
chemicals drop-down combo box. Enter the desired mass or volume of chemical 
needed and press OK. 
 
Pouring/decanting: 
 
Pouring or decanting, involves selecting a piece of lab equipment, positioning its 



left side or center (in the case of watch glasses and evaporation dishes) over the 
receiving container and selecting the decant button from toolbar or decant/pour 
menu item from the procedures menu or from the right-mouse-button context 
menu. Note: liquid is first transferred in this process, to allow separation. 
 
Heating: 
 
Similarly to heat an object with a bunsen burner or hot plate, position the burner 
or hot plate under that object.  
 
Adding a Label: 

ChemLab allows a user to add a label to a lab container, along with a short 
annotated note. By selecting a lab container lab and then selecting the label menu 
item in the procedures menu or right-mouse-button context menu or by double 
clicking on the container’s label area. This will open up the label dialog box, 
which allows the user to enter a 3 letter label, which is visible on the container 
and a short annotated note, which can be viewed from the label dialog box. 

 
Adding Indicators:  
 
To add an indicator to a piece of lab equipment, select it and then press the 
indicator menu option in the Chemical main menu or the right-mouse-button 
context menu. This will open a dialog box which list available indicators and their 
color change characteristics. Not all labs use indicators so this menu will often 
appeared greyed. 
 
Combining Equipment: 
 
Selecting two pieces of lab equipment, which fit into each other, allows the 
combining of lab equipment (arrange menu). Combining places one piece of lab 
equipment into another, this can be used to arrange a cooling or hot water bath. 
To remove two previously combined pieces of lab equipment select the combined 
object and select the remove menu option from the arrange menu or pop-up 
context menu. 
 
 
Weighing: 
 
The sample weight of a container may be displayed by selected a single item and 
using the “Show Weight”  toolbar button, menu item in the equipment menu or 
from the popup context menu. A user can also remove an existing sample weight 
from a container by this same process. Note that the sample weight does not 
include the weight of the container. 
 
The weight of a container and its contents can be measured using a balance.  To 
weigh a piece of lab equipment using a balance, position the container onto the 
weighing pan. 



 
 
 
Filtering: 
 
In ChemLab a Buchner funnel may be added to an Erlenmeyer flask for filtering 
by first selecting the flask and then picking the Buchner funnel from the toolbar, 
equipment menu or right-mouse-button context menu. To remove the funnel, do 
the same. If any solid is present in the filter a dialog box will appear asking 
whether you wish to discard or keep and place it another container.   
 
 
Stirring: 
 
ChemLab allows the addition of a stirring rod or magnetic stirrer for mixing to 
selected lab containers with some contents. The stirring rod may be added to a 
single selected item by pressing the stirring rod button on the toolbar, selecting 
stirring rod from the equipment menu or from the popup context menu. A user 
can also remove an existing stirring rod from a container by this same process. 
The stirring rod will remain in a container for only a few seconds; to continue 
stirring the user must re-select the stirring rod.  
 

To use as a magnetic stirrer, simply place the container on top of the unit. Note 
that the container will automatically be moved into position and the stirring stone 
will appear inside the container. To regulate the rate of stirring, select the unit 
with a left-mouse click and then call up the context menu with a right-mouse 
click. From the Hot Plate & Mag Stir Options menu, the stirring maybe increased, 
decreased or turned off. These settings may also be changed by selecting Magnetic 
Stirrer under the ChemLab Options menu. 

 
Measuring Temperature with a Thermometer: 
 
ChemLab allows the addition of a thermometer to selected lab containers. The 
thermometer may be added to a single selected item by pressing the thermometer 
button on the toolbar, selecting thermometer from the equipment menu or from 
the popup context menu. A user can also remove an existing thermometer from a 
container by this same process. 
 
Titration: 
 
A titration dialog box is opened when a new buret is added. The titration dialog 
box is used to control the rate of flow leaving the buret. A slider control in the 
dialog box labeled stopcock is used for this purpose. If an existing buret is 
selected when the buret button or menu is pressed no new buret will be added, 
rather the titration dialog box will then refer to the previously selected buret. To 
identify which buret the titration dialog box refers to; the burets label value is 
added to the dialog box’s title bar. Note, only one titration dialog box can be 



opened at a time. The titration dialog box also updates the current volume of the 
buret to the nearest tenth of a ml and can be used to record the start and end-
points of a titration. 
 

The Chemical Properties Dialog Box: 

The Chemical Properties dialog box shows the current chemicals and their states 
in a piece of lab equipment. The Chemical properties dialog box can be displayed 
by double clicking on a container or using the Chemicals Properties menu in the 
procedures menu or the right mouse click context menu. Where applicable, the 
molecular structure of a chemical may be studied by selecting it and clicking on 
the Molecular Viewer button. 

 
ChemLab Lab Wizard Tool: 
 

Lab Wizard is a tool used to design chemistry lab simulations files referred to as 
UDL files (User defined Lab). The Lab Wizard will step the user through the 
process of creating a lab simulation by asking them to supply documentation files, 
chemical data, reaction formulas and option settings.  

 
 
Creating a UDL, with the Lab Wizard: 
 

1. Select the ChemLab Wizard from the simulation dialog box (simulation 
dialog box,  appears at startup or when the users specifies new reaction) 

2. From the File menu select "Create UDL..." menu. 
3. Lab Introduction dialog, displays copyright information. <Read and select 

Next> 
4. Lab Information dialog, specify the File Name, Lab title and short lab 

description. This information will appear later in the simulation dialog box. 
<Fill in and select Next> 

5. Lab Documentation dialog, user specifies the introduction, procedure and 
results, RTF (Rich Text Format) files. To create these files user should first 
run Word or Other word processor and save the files in an RTF format. 
<Fill in all fields and select Next> 

6. Available chemicals dialog, the user specifies chemicals required for their 
lab from a database of available chemicals.  

7. The user may also add to or modify the chemical database, as they need to.  
8. Modifying the properties of Added Chemicals. Once chemicals are added 

from the chemical database, their properties may be modified; this allows 
chemicals to be marked as products or reactants (reactants will appear in 
the chemicals dialogbox within ChemLab). <Add all chemicals and select 
Next> 

9. Reaction dialog, the user specifies reactions list. Start adding reactions by 
selecting the "Add Reaction button". A reaction detail dialog will appear. 



Name reaction and set any reaction conditions. A new entry will appear in 
Reaction Tree. Drag and Drop Chemicals from the Available Chemical List 
to the leaf nodes labeled "Reactants" and "Products".  

10. A reaction chemical dialog box will appear if successfully dropped, fill in 
the coefficient for the chemical. Continue to drag and drop until you have 
the complete balanced reaction. <Once all the reactions have been added, 
select Next> 

11. Setting Lab Options; the user can set a number of options to a simulation. 
<Set options, select Next> 

12. Adding Indicators; the user can optionally add indicators to a lab 
simulation. <Add indicators and select Next> 

13. Add PDB files; the user can optionally add PDB (protein database files) to 
ChemLab to be displayed in RasMol through the Chemicals Properties 
dialog. <Add PDB files and select Next> 

14. Finish dialog, this is the last step in lab creation process, select Finish and 
the UDL will be created (FileName.udl) in the ChemLab directory. 

15. Your newly created lab will now appear in the Simulation dialog. 
 
 
Adding new Simulations to other computers: 
 
New simulations with dll and udl extension may be added to ChemLab by copying 
them to the ChemLab program folder.  
 
ChemLab will typically be installed in the directory: c:\program files\model 
Science\ChemLab 
 
 
Lab Demonstrations: 
 
The Lab Demonstrations feature enables ChemLab users to play previously 
recorded lab simulations. While playing lab demonstrations, the user sees all the 
steps taken during the running of a simulation, for example, the selection of 
equipment and the adding of chemicals. The user can continue performing the lab 
simulation from the point where the demonstrations ends. While both the 
Professional and Standard Editions of ChemLab can play a demo, only the 
Professional Edition can be used to record and edit one. 
 
To play a demo, select the Lab Demonstrations menu under the File menu and 
select the “Play Lab Demo…” menu option. 
 
Lab Demo Recording (Professional Edition only): 
 
The Lab Demonstrations feature enables a ChemLab Professional user to record a 
lab simulation for later playback. 
 
The demo mode is started by selecting the Lab Demonstrations menu under the 
File menu and selecting the “Start Recording…” option. To activate the demo 
mode you must first give the demonstration a file name with a *.cld extension. 



You then perform the lab as you normally would. When you are finished 
performing the lab, close the demo file by selecting “Stop Recording” from the Lab 
Demonstrations menu. 
 
 
 
 
 
Periodic Table: 
 
The Periodic Table is an interactive periodic table application with a quiz feature. 
The Periodic Table can be launched from within ChemLab (see: Help -> Periodic 
Table) or through the ChemLab Program group menu. 
 


